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Lag et nytt EndNote-bibliotek

Nar du apner EndNote Desktop for fgrste gang, far du en gra skjerm med en menylinje pa toppen.

For & ta programmet i bruk, trenger du et bibliotek, som kan opprettes ved a klikke pa File > New. Gi

biblioteket et navn og klikk Lagre/Save. Det nye biblioteket apnes automatisk.

=  For a apne et eksisterende bibliotek, ga til File > Open Library... og finn frem biblioteket ditt.

= Et EndNote-bibliotek bestar alltid av en EndNote-fil med bibliotekets navn (f.eks. Endnote) og en
mappe med samme navn (Endnote.Data). De to delene ma alltid lagres sammen for at biblioteket
skal fungere problemfritt.

=  For a lage en sikkerhetskopi av biblioteket i en komprimert fil: Ga til File > Compressed Library
(.enlx), og velg hva som skal vaere med i biblioteket. Klikk pd Next/OK for a lagre filen p& gnsket
sted.

Layout

Apner du et nytt bibliotek, vil skjermbildet se slik ut:
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1 —Valg av modus: Lokalt bibliotek, online-sgk, lokalt bibliotek + online-sgk

2 — Referanseoversikt

3 — Gruppepanel: Viser gruppene biblioteket er inndelt i

4 — Referansepanel: Visningsfelt for markert referanse

5 — Visningsvalg for referansepanel: Referansedetaljer, forhandsvisning i henhold til valgt stil, og
vedlegg (vanligvis fulltekst i PDF-format)

6 — Layout: Velg posisjonering og utforming av referansepanelet

7 — Kolonneoversikt. Velg sorteringsfelt. Hgyreklikk for a velge hvilke kolonner som vises

8 — Verktgylinje. Beskrives pa neste side

9 — Meny for referansestiler
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Freud, Sigmund 1953 The method of interpreting dreams: An analysis...  The standard edition of the com... 21.02.2018 Book Section
@ Ghaziuddin, Mohamm... 2005 A family history study of asperger syndrome Journal of Autism and Develop...  01.11.2017 Journal Article
Gillen, ). B,; Martin, B. J... 2016 Twelve weeks of sprint interval training improves ...  PLoS One 01.11.2017 Electronic Article
L Goodhew, Peter J; H.. 2001 Electron microscopy and analysis 12.09.2018 Electronic Book
L] Gowing, Linda; Ali, Ro.. 2017  Opioid antagonists with minimal sedation for o.. Cochrane Database of System... 01.11.2017  Journal Article
Hansen, Tor lvar 2017 Hegskulen pa Vestlandet Store norske leksikon 29.05.2018 Encyclopedia
L Helsedirektoratet 2014 Lokalt psykisk helsearbeid og rusarbeid for vo... 01.11.2017 Government Document
L Helsedirektoratet, 2017 Sunn hurtigmat pa farten 13.09.2018 Web Page
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Eksporter referanser
Sek etter fulltekst online
Apne fgrste lenke som er oppfart i referansen
Apne referansens vedlegg

Sett inn markerte referanser i Word

Formater litteraturlisten i en bestemt stil

Ga til Word
Synkronisering av EndNote Desktop biblioteket med EndNote Online biblioteket
Del biblioteket med andre EndNote-brukere
Meldinger om nylige forandringer i biblioteket
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Kopier referanse fra et online-sgk til det lokale biblioteket
Legg til en ny referanse manuelt
Online-sgk

Importer referanser fra en fil
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Legg nye referanser til biblioteket

Det finnes flere mater a samle referanser i EndNote. Man kan eksportere referanser fra fagdatabaser
ved a laste ned en referansefil, man kan sgke i databaser via EndNote, eller man kan legge inn
referanser manuelt.

Eksporter referanser fra en database

For a eksportere referanser fra en fagdatabase til EndNote, fglger du som regel disse stegene:

1) Sgk etter et emne i en relevant database

2) Kryss av for en eller flere aktuelle artikler i trefflisten

3) Klikk pa en knapp eller lenke med navnet cite, send to, download eller export.
4) Last ned referansene i EndNote- eller RIS-format.

5) Dobbelklikk pa filen for @ apne den i EndNote.

Ting kan ga galt under import av referansene. Opplysninger kan havne feil i felt, og de kan ogsa vaere
registrert feil. Du bgr derfor alltid korrekturlese referansene du har lastet inn.

Nedenfor finner du to eksempler for referanseeksport til EndNote, fra Oria og Google Scholar.
Se hvordan du eksporterer referanser fra andre databaser pa bibliotekets EndNote hjelpesidene
(«Eksport av referanser fra databaser til EndNote Desktop»).

Eksport fra Oria:

1) Sgk opp referansen du vil overfgre
2) Klikk pa sitattegnet: **
3) Klikk pa EndNote Desktop

BOK
Vilt og fisk : jegerens og fiskerens kokebok
2002

Tilgjengeleg fra Hogskulen pa Vestlandet

” [ = & B B B *

SITER E-POST SKRIVUT PERMANENT LE} RIS BIETEX ENDNOTE ONLIM ENDNOTE DESK]

Tegnsett (velg UTF-8) ¥
DOWNLOAD

4) Klikk OK i vinduet som apner seg (du trenger ikke a forandre innstillingene)
5) Lagre filen og/eller &pne den med EndNote
6) Korrekturles den overfgrte referansen

= For aredigere referansen, markerer du den i biblioteket for a dpne den i referansepanelet.
Klikk deg inn i feltet som skal redigeres. Klikk pa File = Save (Ctr/+S) for & lagre endringene.



Reference | Preview | ™ Attached PDFs @' ¥

Reference Type: Book = 'r'E“l -
Rating

Author

Myhr, Eirik

Reuterstrand, Siri

Year
2002

Title
Vilt og fisk : jegerens og fiskerens kokebok

Series Title
Vilt & fiskkokboken

Place Published
O=lo

Publisher
Gyldendal

tion
2, utg.

ISEN
8205307164

Keywords

Fisk
Skandinavia
kokebaker
matoppskrifter
vilt

| eksempelbildet over star en referanse eksportert fra Oria til EndNote. | referansen kom
utgaveinformasjonen med pa norsk (utg.). | EndNote legger referansestilene automatisk til
utg. pa norsk eller ed. pa engelsk, og dette skal derfor ikke vaere med som referansedata. |
feltet Edition skal det bare sta selve tallet. Feltet Series Title skal veere tomt.

For a velge om tomme felt skal vises i referansepanelet, klikk pa tannhjulsymbolet

i hjgrnet av referansepanelet og aktiver/deaktiver Show Empty Fields.

Eksport fra Google Scholar:

1)
2)

3)

Sek opp referansen du gnsker a overfgre
Klikk pa sitattegnet

ipoF] Ressurser av torsk og andre fisk i fjorder pa den norske Skagerrakkysten
J Gjosaster, K Enersen, SE Enersen - 1996 - brage bibsys.no

The abundance, distribution and life history parameters of cod, Gadus morhua L., and other
fish spacies wera studied at the Norwegian Skagerrak Coast. 12 surveys were conducted in
the Zgndeledfjord and the Sandnesfjord in the Riser area during the period March 1993 til1 __.

17 | DY | Sitert av 18  Beslektede artikler Find it @ HVL HTML-versjon <€

| det nye vinduet, klikk pa EndNote



X Referanse

MLA  Gjpsaster, Jakob, Kate Enersen, and Svein Erik Enersen.
"Ressurser av torsk og andre fisk i fjorder pa den norske
Skagerrakkysten.” (1996).

APA  Gjesester, J., Enersen, K., & Enersen, 5. E. (1996). Ressurser
av torsk og andre fisk i fjorder pa den norske Skagerrakkysten.

S0 690 GJASAETER, Jakob; ENERSEN, Kate; ENERSEN, Svein Erik.
Ressurser av torsk og andre fisk i fjorder pa den norske
Skagerrakkysten. 1996,

BibTeX RefMan  RefiWorks ]

4) Lagre filen og/eller dpne den med EndNote
5) Korrekturles den overfgrte referansen

Sek i fagdatabaser via EndNote (Online Search Mode)

| Online Search Mode kan du sgke etter referanser direkte i EndNote, uten at du ma apne databasen
i nettleseren din. En del sgkefunksjoner fra fagdatabasen vil mangle, sa Online Search Mode
anbefales bare for & sgke opp helt bestemte referanser, ikke for selve litteratursgket.

1) Bytt til Online Search Mode @

2) Velg databasen i sidepanelet som du vil sgke i (f.eks. PubMed, Web of Science, LOC)
Klikk pa more... om du ikke ser gnsket database i listen

3) Fyll ut en eller flere sgkefelt og klikk pa Search

4) Kopier referansene til biblioteket ved & markere dem i trefflisten og klikke pa

Copy to Local Library

= NB: Mange databaser krever palogging, og vil veere utilgjengelige for bruk, men du kan forsgke a
logge inn uten brukernavn og passord.

Legg inn referanser manuelt

Referanser for bgker og tidsskriftsartikler kan du stort sett eksportere fra Oria eller fagdatabaser til
EndNote. For en del andre kilder er det ngdvendig a legge inn referansen manuelt, f.eks. nettsider,
avisartikler, lover og forskrifter, rapporter, retningslinjer eller bilde- og lydmateriale.

1) Ga til References > New Reference (Ctr/+N) eller klikk pa El

2) Velg passende Reference Type og fyll ut de ngdvendige feltene
3) Lagre referansen ved & ga til File > Save (Ctr/+S)

4) Lukk referansen. Referansen finner du igjen under All References

For a finne passende Reference Type for kilden du bruker og for a sjekke hvilke felt som ma fylles ut,
kan du se pa eksempelsamlingene pa bibliotekets EndNote-hjelpesider.



Noen eksempler pa referanser som er lagt inn manuelt:
= Lov

Reference | Preview "J. Attached PDFs | @ ¥

Reference Type: Legal Rule or Regulation - {‘E‘l -
Rating
Author

Panteloven

Year

1980

Title

Lowv om pant

Rule Number

LOV-1980-02-08-2

URL

https://lovdata.no/dekument/ ML low,/1980-02-08-2

= Nettside

Reference | Preview |'J. Attached PDFs | @

L]

5::[-

Reference Type: Web Page =
Rating

Author
Helsedirektoratet,

Year

po17

Title

Sunn hurtigmat pa farten
Place Published

Oslo

Fublisher

Direktoratet for e-helse

Last Update Date
15. november

Type of Medium

Internett

Year Cited

2018

Date Cited

13. september

URL
https://helsenorge.nofkosthold-og-ernaring/tips-til-
hverdagsmaten/sunn-hurtigmat




= Standard

Reference | Preview |™ Attached PDFs @ -

Reference Type: Standard - 'r‘lil -
Institution

Standard Morge,

Year

2015

Title

Eurckode 3: Prosjektering av stilkonstruksjoner - Del 1-1: Allmenne
regler og regler for bygninger

Place Published
Oslo

Publisher
Standard Morge

Document Number
MS-EM 1993-1-1:2005+ A1:2014+ NA: 2015

= NB: Feltet Author fylles vanligvis fylles ut i formen:
Etternavn, Fornavn
Organisasjonsnavn som bestar av flere enn ett ord ma fgres inn med komma etter, for a unnga at
navnet inverteres som et personnavn. For eksempel:
Hggskulen pa Vestlandet,

EndNote og Word

Nar EndNote er installert, vil du finne verktgylinje i Word med navn «EndNote X8». Denne bruker du
til a sette inn referanser fra biblioteket ditt, velge gnsket referansestil og for a tilpasse
referansehenvisningene i teksten.

Sett inn referanser

1) Sett markgren der du gnsker referansen, og klikk Insert Citation i EndNote-verktgylinjen

Hjem Sett inn Utforming Oppsett Referanser Masseutsendelser Se gjennom Visning Zatero EndNote X9
N, Go to EndMote Style:  Vancouwver norsk bokmaal - ﬁt— Categorize References = Export to EndMaote = o
o I Edit & Manage Citation(s) l_E,' Update Citations and Bibliography Instant Farmatting is Off = l]mlManuscript Matcher Help
Citation - Ji Edit Library Reference(s) R Convert Citations and Bibliography = E Preferences
Citations Eibliography N Tools

2) Sek etter referansen du vil sette inn, f.eks. pa forfatter, ord i tittel eller arstall.



EndMote X8 Find & Insert My References >

ﬂ jacobs B | Find ]

Author Year Tite

Jacobs 2017 Prevalence of and outcomes from Staphylococous aureus pneum)

£ >
Reference Type:  Journal Article ~
Record Number: 52
Author: Jacobs, David M.

Shawer, Amy
Year: 2017
Title: Prevalence of and outcomes from Staphylococous aureus

pneumonia among hospitalized patients in the United
States, 2009-2012

Journak American Journal of Infection Control

Volume: 45

Issue: 4

Pages: 404-409

ISSH: 0196-6553 A
Library: My EndMote Library.enl 1items in list

3) Med et klikk pa Insert setter du inn en henvisning i teksten, og referansen blir lagt til
i litteraturlisten pa slutten av dokumentet.

=  Huvis du bruker en forfatter-arstall-referansestil, kan du i nedtrekksmenyen av Insert
velge om du vil ha bade forfatter og arstall (Insert), bare arstall (Insert & Exclude Author)
eller bare forfatter (Insert & Exclude Year) med i teksten.
Du kan ogsa bare legge til referansen i litteraturlisten (Insert in Bibliography Only),
eller sette forfatteren utenfor parentes (Insert & Display as: Author (Year))

Cancel Help

Insert

Insert & Display as Author (Year)
Insert & Exclude Author

Insert & Exclude Year

Insert in Bibliography Only

= Alternativ kan du bytte til EndNote, finne fram referansen(e) du vil sette inn, og klikke pa
symbolet IE‘ .
Velg referansestil og design av litteraturlisten

= Velg referansestil i stilimenyen.
= Klikk Select Another Style... for a finne installerte stiler som ikke er i listen.



Fil Hjem Sett inn Utforming Oppsett Referanser Masseutsendelser Se gjennom

|,,| &, Go to EndMote [gtyle: APA narsk bokmal 2018 - I &-Categorize References =

EI:;‘ Edit & Manage Citation(s) LE,I Update Citations and Eibliography Instant Formatting is On -

Insert
Citation = E;'; Edit Library Reference(s) |Z_'1'-, Convert Citations and Bibliography ~

Citations [ Bibliography m]

= Du kan tilpasse font, skriftstgrrelse, innrykk, linjeavstand og avstand mellom
referansene i litteraturlisten under Blibliography 2 Layout

EndMote X8 Configure Bibliography >

Format Bibliography|
Font: Size:

Bibliography title:

Text Format...

Start with bibliography number:

First lime indent: | 0.000 cm Line spadng: | Single w
Hanging indent: Space after:  |None ~

wort | [ i

Rediger og slett henvisninger

For a redigere referansene i et Word-dokument, bruker du funksjonen Edit & Manage Citation(s).
NB: Ikke skriv direkte inn i formaterte EndNote-felt! Det vil fgre til at endringene tilbakestilles
eller at formateringen gar tapt.

Fil Hjem Sett inn Utfarming Oppsett Referanser Masseutsendelser Se gjennom
55 &4, Go to EndMote Style: |APA norsk bokmal 2018 - @- Categorize References =

| @ Edit & Manage Citation(s]] LE,' Update Citations and Bibliography Instant Formatting is On -
nsert
Citation = E;'x. Edit Library Reference(s) B2 Convert Citations and Bibliography ~

Citations Eibliography [F}

= Det apnes ett nytt vindu med en oversiktsliste over referansene i dokumentet.



EndMote X8 Edit & Manage Citations X

-~

Citation Count  Library =

(Hato et al., 2017)

. . Hato, 2017, Developm... 1 U= I BT ETE | Edit Reference | -

(Meyer, 2017) C/D

Meyer, 2017 #15 1 Traveling Library
(5tandard Morge, 2015)

Standard Norge, 2015... 1 Traveling Library Edit Reference | -~
(Lietal., 2017)

Li, 2017 #13 1 Traveling Library Edit Reference |
(Clauser, 1356; Hategeka, Shoveller, Tuyisenge & Lynd, 2017) W

Edit Citation  Reference

[ Formatting: |Default Vl B
Prefix:
Suffix:
A
TJools - Cancel Help

Totals: 24 Citation Groups, 30 Citations, 30 References

A) Legg til sidetall

= | feltet Pages kan du legge inn sidetall for henvisningen i teksten. Dette gjelder for den
aktiverte henvisningen, og vil ikke pavirke andre instanser.

= Noen stiler stgtter ikke sidetall direkte, og da ma du legge det inn med Suffix istedenfor
Pages.
Pages = Skriv inn bare tallet
Suffix = Skriv inn «, s. sidetall»

= Klikk OK nar du er ferdig med redigering av referansen.

Eksempel:
F@r redigering: (Myhre, Marshburn & Toverud, 1989)
Etter redigering: (Myhre, Marshburn & Toverud, 1989, s. 48)

B) Fjern forfatternavn eller arstall fra henvisning in teksten

= Under Formatting kan du velge om du vil ha forfatter og arstall med
i referansehenvisningen.

Edit Citation Reference

Formatting:  |Default ~
Prefix: Display as: Author (Year)
Exclude Author
Suffix: Exdude Year
Exclude Author & Year
Pages: Show Only in Bibliography

= Klikk OK nar du er ferdig med redigering av referansen.

C) Legg til en referanse pa samme sted som en eksisterende

10



= Klikk pa Edit reference og velg Insert Citation.

(Hato etal., 2017)
B B +ato, 2017, Developm... 1 Traveling Library B4tz taay
(Meyer, 2017) Edit Library Reference
Meyer, 2017 #15 1 Traveling Library Find Reference Updates...
(5tandard Morge, 2015) Remove Citation
Standard Morge, 2015.., 1 Traveling Library
(Lietal, 2017) Update from My Library...

= Klikk OK nar du er ferdig med redigering av referansen.

D) Slette referanser

= Klikk pa Edit reference og velg Remove Citation.

(Hato etal., 2017)

B B +ato, 2017, Developm... 1 Traveling Library |- sk
(Meyer, 2017) Edit Library Reference
Meyer, 2017 #15 1 Traveling Library Find Reference Updates...
(Standard Morge, 2015)
Standard Morge, 2015... 1 Traveling Library Ineert Citation

(ietal, 2017) Update from My Library...

= Klikk OK nar du er ferdig med redigering av referansen.
= Henvisningen til referansen er na slettet fra dokumentet. Referansen ligger fremdeles i

biblioteket.

Oppdatering, formatering og konvertering av referanser i Word

A) Oppdatere referanser

Nar du redigerer referanser i EndNote-biblioteket, ma de oppdateres i Word-dokumentet.
Dette gjgres automatisk innimellom, men kan gjgres manuelt ved a klikke pd Update
Citations and Bibliography. Denne funksjonen finner du rett under stilmenyen.

Fil Hjem Sett inn Utfarming Oppsett Referanser Masseutsendelser Se gjennom
|,,| &, Go to EndMote Style: | APA norsk bokmal 2018 - @-Categorize References -

Insert

|!_'l",‘ Edit & Manage Citation(s) l LE,' Update Citations and Bibliography] Instant Formatting is On ~
Cilafion ™ E;'x. Edit Library Reference(s)

% Convert Citations and Bibliography ~

Citations Eibliography [F}

11



B) Avformatere referanser

Skal du flytte tekstavsnitt som inneholder EndNote-referanser eller sla sammen flere
dokumenter, bgr du avformatere referansene fgr du klipper og limer. Da vil Word arbeide
raskere. | sjeldne tilfeller kan kopiering av formaterte EndNote-referanser medfgre feil.

Klikk pa Convert Citations and Bibliography - Convert to Unformatted Citations

Fil Hjem Sett inn Utforming Oppsett Referanser Masseutsendelser Se gjennom
75 €N, Go to EndNote Style: |APA norsk bokmal 2018 A il::- Categorize References =

E,‘Edit&MEﬂE ECitEtiDﬂ[ﬂ
+ 9
Insert

Criafion ™ E];'; Edit Library Reference(s)

LE,[ Update Citations and Bibliography

Instant Formatting is Off ~

[2 Convert Citations and Bibliography -

Citations

'_’T: Convert to Unformatted Citations l

B} Convertto Plain Text R

Convert Reference Manager Citations to EndMNote

~

ﬂi Convert Word Citations to EndMNote

Referansene erstattes av EndNote-koder, og litteraturlisten forsvinner.

(Myhre, Marshburn & Toverud, 1989, s. 48) = {Myhre, 1989, Patologi@48}

Klikk pa Update Citations and Bibliography for a fa referansene tilbake til formatert form.

C) Konverter referansene til tekst

Det er mulig a opprette et Word-dokument hvor forbindelsen til EndNote er brutt. Her kan
du gjgre siste finpuss i referansene. Dette burde vaere det siste man gjor fgr eventuell lagring
som PDF eller fgr man sender dokumentet fra seg.

NB: Ta vare pa det opprinnelige dokumentet, der EndNote-kodene er intakt. De kan ikke

gjenopprettes i det nye dokumentet.

= Klikk pa Convert Citations and Bibliography = Convert to Plain Text

Fil Hjem
7

Settinn Utforming

M, Go to EndMote

B2} Edit & Manage Citation(s)
Insert
Citation = E.n'. Edit Library Reference(s)

Citations

B

Oppsett

Style: | APA norsk bokmal 2018 -
|_E,|~ Update Citations and Bibliography

Conwv

Referanser Masseutsendelser Se gjennom

Ex& Categorize References -
Instant Formatting is Off =

m Convert Citations and Bibliography -

ert to Unformatted Citations

L E‘

Conwv

ert to Plain Tesxt ] el Ee 0

Convi

~

: a:
Organiser EndNote-biblioteket

Organiser biblioteket i grupper

Conwv

ert Reference Manager Citations to EndMote

ert Word Citations to EndMote

Du kan holde orden i biblioteket ved a legge referansene i grupper.

= Custom groups:

For a lage en ny gruppe, ga til Groups = Create group. Den nye gruppen finner du igjen under
My Groups i gruppepanelet. Du kan gi et navn til gruppen ved a hgyreklikke pa den og velge
Rename Group. For a legge en referanse i gruppen, drar du referansen fra listen i All References

til gruppen i gruppepanelet.
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=  Smart groups:

Smartgrupper samler referansene etter gitte kriterier. For a lage en ny smartgruppe, ga til
Groups = Create Smart group. Det apnes et nytt vindu i det du kan velge et navn for gruppen og
sette kriterier for referansene. Du kan f.eks. sgke etter forfatter, arstall, opprettelsesdato,
database eller ngkkelord. Klikk Create for a opprette smartgruppen.

Smart Group x

Smart Group Name: |New Smart Group

|Author V| | Contains V| | id| |

|And V| |‘r'ear V| | Contains V| | +| |-

[and | [Titie || contains v +] [
Create Options. .. * DMatd1 Case DMabﬁ Words

Slette dubletter

For & unnga stgy fra referanser som er importert flere ganger, kan du sjekke biblioteket ditt for
dubletter. Ga til References = Find Duplicates. Finnes det dubletter i biblioteket ditt, dpnes det et
vindu der du kan sammenligne dublettene. Velg referansen du vil beholde ved 3 klikke pa Keep This
Record.

Legg til fulltekst

Har du lagret fullteksten til en artikkel, kan du knytte den til referansen i EndNote-biblioteket ditt.
Legg ved en PDF ved a klikke pa den aktuelle referansen i EndNote og a klikke pa binders-symbolet i
referansepanelet.

™" Attached PDFs @

There are no POFs attached to this reference.

Finn fulltekst pa nett

EndNote kan ogsa sgke opp fulltekst pa nett. EndNote gjgr da et oppslag basert pa DOl og andre
opplysninger i referansen. Man kan ogsa gjgre oppslag i Oria, med OpenURL Link. Dette krever
registrering av HVLs OpenURL-server:

1) Ga til Edit > Preferences - Find Full Text
2) Skriv HVLs OpenURL i feltet OpenURL Path:
http://openurl.bibsys.no/openurl

3) EZProxy-serveren settes inn i feltet Authenticate with: URL:
https://login.galanga.hvl.no/login?
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EndMote Preferences *

Change (;ase The Find Full Text feature uses several technologies to madimize the
- Display Fields chances that EndNote will find all available PDFs. Use this screen to
.. Display Fonts control these full text search options:

- Duplicates [] Web of Science Full Text Links

W Find Full Text

- Folder Locations DOl (Digital Object |dentifier)

- Formatting PubMed LinkOut {U.S. National Library of Medicine)

- Libraries

.. PDF Handling [~ OpenURL

- Read / Unread OmemURL Path:

- Reference Types [ pen ) | I
- Sarting Autherticate with:

- 5pell Check

Tempo.rar)r Citations Examples: https:/Aogin.ezprowy library myuniversity edu.login

- Term Lists http://auth universityname edu/authentication

. JRLs & Links

[ Automatically invoke Find Full Text on newhy-mported references

EndMote Defauts Revert Panel Avbryt Bruk

Marker referansene du gnsker fulltekst til, og klikk pa Find Full Text: @' Fullteksten som blir funnet
pa nett blir na lastet ned og knyttet til referansen i biblioteket. Referanser med fulltekst er merket

med et binders-ikon.

Synkroniser biblioteket med EndNote Online

Du kan synkronisere EndNote-biblioteket med en online-konto via Sync funksjonen. Dette gj@r det
lettere a fa tilgang til biblioteket fra andre datamaskiner, og du kan jobbe med biblioteket hvor og
nar du vil, sa lenge du har tilgang til internett. Du kan enten opprette en konto for EndNote Online

pa siden https://myendnoteweb.com, eller ved 3 klikke pa Sync O . Om du setter opp andre
datamaskiner til 3 synkronisere mot den samme kontoen, vil de kunne benytte samme bibliotek.
Biblioteket er ogsa tilgjengelig i EndNote Online.

For mer informasjon om EndNote online, se «kKom i gang med Endnote online» pa bibliotekets
EndNote-hjelpesider.

Del biblioteket

| EndNote Desktop kan du dele et helt bibliotek, og kun ett. Klikk File = Share (eller Share Library
ek ). Om du ikke har satt opp synkronisering, tar EndNote deg f@rst giennom denne prosessen. For
a dele biblioteket, fgrer du inn epost-adressene for samarbeidspartnerne i det midterste feltet i
Sharing-vinduet (Invite More People). Klikk Invite, sa blir det sendt delingsinvitasjoner pa epost.
Mottakerne far en lenke til EndNote Online, og etter a ha logget seg inn, vil de finne igjen det delte
biblioteket i EndNote Desktop under File = Open Shared Library..., forutsatt at EndNote Desktop er
synkronisert til den samme kontoen.
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Om du ikke finner gnsket referansestil i EndNote stilsamlingen

Last ned referansestiler

Det finnes en rekke forskjellige stiler til nedlasting pa EndNotes nettsider. HVL har et mindre utvalg

pa norsk.

Har du lastet ned en referansestil fra nett, installerer du ved a dpne filen, og deretter lagre den: File

-> Save As... Velg et navn for stilen og klikk Save.

Se lenkene under «Referansestiler» pa bibliotekets EndNote-hjelpesider for referansestiler tilpasset

for HVL.

Redigering av eksisterende referansestiler

Vil du tilpasse en referansestil, f.eks. endre forkortelser, er det enklest a redigere en eksisterende stil.

1) Ga til Edit > Output Styles > Open Style Manager...

| oversiktslisten av stiler kan du krysse av stilene som vises i stiimenyen i EndNote og Word.

2) Marker stilen du gnsker a redigere og klikk Edit
3) Tilpass det du gnsker og avslutt med File = Save As...

Noen vanlige redigeringsmuligheter:

= Velg om tidsskrifttittel skal forkortes:
Journal Names
=  Bytte ut engelske mot norske ord (and til og) i referansehenvisning:
Citations - Author Lists
= Bytte ut engelske mot norske forkortelser for sidetall:
Citations > Templates: erstatt «p.» med «s.»
Bibliography > Templates: erstatt «p.» med «s.»

= Det meste av stilen er definert under Bibliography > Templates. Her er det definert hvilke
EndNote-felt som skal vises for de forskjellige referansetypene i litteraturlisten. Skal du

redigere noe her, bgr du vaere veldig ngyaktig med tegnsettingen for a fa en feilfri
referansestil! For a legge til et nytt felt, klikk pa Insert Field og velg aktuell felt.
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Andre nyttige funksjoner i EndNote

Quick Search

Du kan bruke funksjonen «Quick Search» for a finne fort frem til en bestemt referanse i biblioteket.

2 B W[ (O L “u -

®‘ Quick Search Q. = | ¥ Show Search Panel

PDF-redigering

Det er mulig redigere PDF-filer knyttet til referanser i EndNote, f.eks. markere eller understreke
tekstpassasjer, legge til notater, etc.

Tittelregister for tidsskrifter

Noen databaser eksporterer referanser med forkortet tidsskrifttittel, og noen referansestiler krever
full tittel — og omvendt. EndNote kan oversette mellom kort og fullstendig tittel, og kommer med
ferdige tittelregistre for ulike fagomrader:

1) Gatil Tools 2 Open Term Lists 2 Journal Term List

2) Marker alle termer i listen og klikk pa Delete Term

3) Bytt til fanen Lists og klikk pa Import List...

4) Velg en aktuell liste (bare én) og klikk Apne for & importere listen

Importer referanser fra PDF

EndNote har en funksjon for a importere referanser basert pa fulltekstartikler i PDF format. Dette vil
som regel bare fungere for nyere PDF-er med DOI.

= Import av en enkelt PDF-fil:

1) Ga til File > Import - File...

2) Klikk pa Choose... og finn frem PDF-filen du vil importere
3) Velg Import Option: PDF

4) Klikk pa Import

= |Import av en mappe med PDF-filer:

1) Ga til File > Import = Folder...

2) Klikk pa Choose... og finn frem mappen med PDF-filene du vil importere

3) Velg Import Option: PDF

4) Kryss av for «include files in subfolders» om du vil ogsa importere filer i undermapper
5) Klikk pa Import
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